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IMPORTANT NOTICE 

All statements, technical information and recommendations in this document which relate to the 

products supplied by Meggitt Sensing Systems are based on information believed to be reliable, but 

unless otherwise expressly agreed in writing with Meggitt SA, the accuracy or completeness of such 

data is not guaranteed. Before using this product, you must evaluate it and determine if it is suitable 

for your intended application. Unless otherwise expressly agreed in writing with Meggitt SA, you 

assume all risks and liability associated with such use. Meggitt Sensing Systems takes no 

responsibility for any statements related to the product which are not contained in a current English 

language Meggitt Sensing Systems publication, nor for any statements contained in extracts, 

summaries, translations or any other documents not authored and produced by Meggitt Sensing 

Systems. 

 

 

 

EXPORT CONTROL 

The information contained in this document may be subject to export control regulations of the 

European Community, USA or other countries. Each recipient of this document is responsible for 

ensuring that the transfer or use of any information contained in this document complies with all 

relevant export control regulations. ECN N /A. 

 

 

 

COPYRIGHT 

Copyright © Meggitt SA, 2013 

All rights reserved 

Published and printed by Meggitt SA in Fribourg, Switzerland 

The names of actual companies and products mentioned  

herein may be the trademarks of their respective owners. 

The information contained in this document is subject to change without notice.  

This information shall not be used, duplicated or disclosed, in whole or in part,  

without the express written permission of Meggitt Sensing Systems. 
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PREFACE 

 

About these release notes 

This document provides important information about the VibroSight ® software from Meggitt Sensing 

Systems. It is applicable to all VibroSight-based condition monitoring and machinery protection 

systems using the versions of software described by this document, namely: 

VibroSight software version 2.10.1 (CD part number 609-004-000-019). 

This document contains information about changes to the software since the previously released 

version (VibroSight 2.10.0), such as new features and improvements, solved problems and bug fixes, 

and hardware and software compatibility. 

For more general information on the actual software, or the entire condition monitoring system (CMS), 

refer to the following Meggitt Sensing Systems (MSS) documentation: 

 VibroSight software data sheet (MSS document ref. 660-020-005-213A) 

 Getting started with VibroSight installation guide (MSS document ref. 660-010-006-216A) 

 VibroSight help 

 VibroSight application notes and technical notes. 

Users who are familiar with previous versions of VibroSight may also find it useful to refer to the 

respective release notes included in their installation. 

 

Structure of the release notes 

This document presents information in the following order: general items first, then in terms of the 

software modules that constitute VibroSight, such as  Configurator,  Server,  Vision and so 

on. 

You should read those sections that are most relevant to you and then keep the document for future 

reference. 

 

Version identifiers 

A complete VibroSight software product version number has four components x.x.x build x (or x.x.x.x) 

that provide the following information: 

 Major release identifier: x.x.x build x (or x.x.x.x) 

 Minor release identifier: x.x.x build x (or x.x.x.x) 

 Update identifier: x.x.x build x (or x.x.x.x) 

 Build identifier: x.x.x build x (or x.x.x.x). 
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The version identifiers for installed software appear in the Help About box (obtained using 

Help > About … in any VibroSight software module). 

 

Terminology 

To distinguish between the different Meggitt Sensing System products that can be used with the 

VibroSight software, the following terminology is used in this document: 

 VM600 card – to refer to the VibroSight-software compatible cards that are installed in a VM600 

rack. The currently available VM600 cards that are designed for operation with the VibroSight 

software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T) and the CPUR card (for configuration only). 

Where XMx16 card is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T cards, unless otherwise stated. 

 VibroSmart DMS module or VibroSmart DMS device – to refer to VibroSight-software 

compatible modules or devices that are used in a distributed monitoring system. The currently 

available VibroSmart DMS modules and devices that are designed for operation with the 

VibroSight software are the VSI010, VSN010 and VSV300. 

Where VibroSmart DMS module is used in this document, it refers to VSI010 and VSV300 

modules, unless otherwise stated. 

Where VibroSmart DMS device is used in this document, it refers to the VSN010 device, unless 

otherwise stated. 
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1. Licensing 

In general, the licence key required to enable purchased product options remains unchanged between 

update level releases. For example, from version 2.10.0 to version 2.10.1. 

However, a new licence key is required for upgrades between major and minor version releases. 

For example, from version 2.9.x to version 2.10.1. 

To obtain a new VibroSight licence key file or for further information on licence keys, contact Meggitt 

Sensing Systems customer support. See section 7. 

 

 

2. Features 

General 

2.1. Features for the VibroSmart DMS 

VibroSight 2.10.1 contains features for the VibroSmart DMS that have been activated in order to 

ensure compatibility with future releases of VibroSmart module firmware.  

NOTE: However, this means that the current (or earlier) versions of the firmware for the 

VSI010 and VSV300 modules are not compatible with VibroSight 2.10.1. 

 

See sections 2.3 and 2.4 for more information on these features. 

 

 

 VibroSight Configurator 

2.2. Reworked user interfaces for the configuration of VibroSight Modbus 
Servers and VibroSight OPC Servers 

The configuration of the following data export interfaces has been simplified and improved in order to 

make them more user friendly: 

 VibroSight Modbus server 

(File > New > Modbus Server Configuration) 

 VibroSight OPC server. 

(File > New > OPC Server Configuration). 

The improvements to these user interfaces have also made them more consistent, in that the controls 

used and their behaviour is as similar as possible to the VibroSmart Modbus, OPC and Profibus data 

export user interfaces. See also section 2.3. 
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2.3. Reworked user interfaces for the configuration of Modbus interfaces and 
Profibus interfaces for VibroSmart VSI010 modules 

The configuration of the following data export interfaces has been simplified and improved in order to 

make them more user friendly: 

 Modbus interface (fieldbus port) for a VibroSmart VSI010 module 

(Right-click on the Fieldbus Ports node under a VibroSmart VSI010 module in the Hardware 

view tool window and click New Modbus Port) 

 Profibus interface (fieldbus port) for a VibroSmart VSI010 module. 

(Right-click on the Fieldbus Ports node under a VibroSmart VSI010 module in the Hardware 

view tool window and click New Profibus Port). 

The improvements to these user interfaces have also made them more consistent, in that the controls 

used and their behaviour is as similar as possible to the VibroSight Modbus Server and OPC Server 

user interfaces. See also section 2.2. 

 

2.4. Input signal inversion for VibroSight VSV300 module position processing 

The Position Processing block for a VibroSmart VSV300 module now allows the signal from the input 

channel to be inverted. More specifically, the sign of the input value can be optionally inverted using a 

Signal Inverted control, in accordance with the following position processing formula: 

Xout = (Xin × Sinv) – Xinitial,  where Sinv is the Signal Inverted parameter which can have a value 

of +1 or –1. 

The Signal Inverted control is available on the Position Extraction node under a Position Processing 

Block and is used as follow: 

 Clear the Signal Inverted check box to configure no signal inversion: Sinv = +1 (the default). 

 Select the Signal Inverted check box to configure signal inversion: Sinv = –1. 

 

 

 VibroSight Vision 

2.5. Logarithmic scales for certain plots 

The logarithmic scale is now available for the following types of plot: 

 For the y-axis of Spectrum plots 

(Y-Axis tab of the Plot Properties window, under Scale) 

 For the y-axis of Waterfall/Cascade plots 

(Y-Axis tab of the Plot Properties window, under Scale) 

 For the colour scale of Spectrogram plots. 

(Color scale tab of the Plot Properties window, under Scale). 

This improvement allows VibroSight to be used for the stochastic analysis of vibration signals. 
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2.6. Configurable reference level for the decibel scale for certain plots 

The reference level used for the decibel scale is now configurable for the following types of plot: 

 For the y-axis of Spectrum plots 

(Y-Axis tab of the Plot Properties window, under Scale) 

 For the y-axis of Waterfall/Cascade plots 

(Y-Axis tab of the Plot Properties window, under Scale) 

 For the colour scale of Spectrogram plots. 

(Color scale tab of the Plot Properties window, under Scale). 

Either the default decibel reference value (Default) can be used or a different decibel reference value 

can be entered using the Plot Properties window. (The reference level (Ref. level) is only available to 

be edited when Decibels is selected as the Scale.) 

The default decibel reference values (equivalent to 0 dB) for different physical quantities are 

configured on the Decibels tab of the Default Plot Settings available under Tools > Options. 

In addition, a Ref. level column can be added to the legend at the bottom the plot document window 

to display the reference level used for the decibel scale. 

 

2.7. Feedback on the measurement data items displayed in historical data plots 

For plots created using historical data, fewer data items than the total available in the database can be 

displayed, according to a data reduction algorithm that considers the data handling limits configured 

for plots (Tools > Options, then Environment \ Data Handling Limitation). See also section 2.8. 

NOTE: Smaller numbers (lower processing overhead) improve the system response time 

but reduce the resolution of the plots. 

 

Historical data plots now display information on the number of measurement data items that are 

displayed in the plot. 

NOTE: For static plots, the number of measurement data items displayed is a count of the 

number of points per measurement included in the plot. 

For dynamic plots, the number of measurement data items displayed is a count of 

the number of waveforms, spectra or orbits per measurement included in the plot. 

 

Information on the number of measurement data items included in a plot is available from two 

locations: 

 In the summary bar at the top of every plot document window (top right, just before the data 

quality indicator). 

This item count is the total number of data items included in the plot. To display additional 

information about the data items, move the pointer over the data items in the summary bar in 

order to display an on-screen tip. 
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 In the legend at the bottom of every plot document window, in the Items column (optional). 

This item count is the number of data items included in the plot for an individual curve. To 

display additional information about the data items, move the pointer over the data items cell 

in the legend in order to display an on-screen tip. 

If the number of data items included in a plot has been reduced by the data handling limits, then a filter 

icon is displayed in the item count displayed in the summary bar at the top of the plot and the on-

screen tip will provide additional information (for example, “Data reduction has been applied”). 

 

2.8. Data handling limits for historical data plots 

The default values and the maximum permitted values (hard-coded limits) for the user configurable 

data handling limits have changed: 

 The default data display limit for variables (static plots) is now 150000 data items (was 10000) 

and the maximum permitted value is now 1000000 (was 120000). 

 The default data display limit for waveforms, spectra and orbits (dynamic plots) is now 500 data 

items (was 60) and the maximum permitted value is now 1000 (was 500). 

NOTE: These data display limits are on a per curve basis. 

For example, with a data display limit of 150000 data items for variables, each 

curve displayed in a Trend plot is limited to 150000 data items. But multiple curves, 

each up to 150000 data items, can be displayed in the same Trend plot. 

 

The data handling limits are used by a data reduction algorithm to display fewer data items in a plot 

than the total available in the database. 

NOTE: Smaller numbers (lower processing overhead) improve the system response time 

but reduce the resolution of the plots. 
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3. Solved problems and bug fixes 

General 

3.1. Improvements and bug fixes 

General improvements and bug fixes throughout the VibroSight software modules, including: 

 Improvements to VibroSight Vision that have greatly reduced previously seen performance 

issues that affected the display of plots when viewing live data (typically characterised by data 

being displayed with delays, data being updated non-continuously, or delays before plots were 

updated when switching between different plots in a VibroSight Vision project). 

 Improvements to the database data management tools and in particular, the command-line tools 

for database copy, purge and backup operations, in order to allow more reliable operation with 

task schedulers running on a computer to automate the management of VibroSight databases. 

 General stability improvements and multiple bug fixes across the various software modules that 

constitute VibroSight. 
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4. Known issues 

4.1. Small “holes” in plotted data for large VibroSight Vision projects when 
viewing live data 

Depending on the complexity of a VibroSight application and the performance of the computer running 

the VibroSight software, the responsiveness of VibroSight Vision can decline under certain situations 

and affect the display of plots when viewing live data. 

In particular, this performance issue has been seen with large VibroSight Vision projects containing 

many open plots using live data. It is typically characterised by plots being displayed with small “holes” 

in the data, corresponding to when the computer has reached its performance limits. 

If this behaviour is seen, the recommended workaround is to: 

 Reduce the number of active plots in the VibroSight Vision project in order to reduce the 

computational load, as only the currently displayed (foreground) plots are constantly 

refreshed. Plots that are hidden or minimized (background) are not active and will only be 

refreshed when they become visible again. 

 If it is necessary to view historical data at the same time, consider using a separate VibroSight 

Vision session to work with the historical data, preferably on a different computer. 

 

4.2. VibroSight Server reference clocks 

In order to ensure that the time is set accurately and remains synchronized for all of the components 

used in a VibroSight-based system, all of the components (VibroSight Server and VM600 XMx16 

cards or VibroSmart DMS devices) should be configured to use the same NTP server as a reference 

clock. 

In the event of a problem with the NTP server such as step changes in time or excessive drift, the 

VibroSight Server will revert to using the local host computer clock as a backup reference clock. 

However, under certain circumstances (probably related to the quality of the reference clocks used in 

a system), a VibroSight Server can experience problems with the reference clock that affect system 

operation. For example, switching from an NTP server to the local host computer clock can produce a 

step change in time for a VibroSight Server which can result in problems communicating with VM600 

XMx16 cards, logging data and timestamping measurements. 

 

4.3. Incomplete use of qualifiers in VibroSight Vision (D#5678) 

In VibroSight Vision, the measurements displayed in the cursor columns of a plot’s legend include the 

physical quantity and the unit, and the qualifier (rectifier) that is used for the measurement. 

However, the qualifier that is displayed uses the abbreviation from the qualifier’s family rather than the 

abbreviation from the qualifier’s group (which is more unique). As a result, it can be necessary to verify 

the qualifier that was configured in VibroSight Configurator in order to be sure of the qualifier that is 

used for the measurement, that is, to be sure from which qualifier group the rectifier comes. For 

example, the Time Domain True RMS, the Time Domain True Peak or Time Domain True Peak-Peak 

group. 
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For example, in a time domain plot, pk for peak and pp for peak-to-peak displayed in the plot’s legend 

could be from the Time Domain True RMS group (s_pk and s_pp) or from the Time Domain True 

Peak group (t_pk and st_pp) or from the Time Domain True Peak-Peak group (st_pk and t_pp). 

 

4.4. VibroSight Server and Host Service restart required after changes to 
network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or 

disconnected) on a computer running VibroSight, then the VibroSight Servers and Host Services 

running on the computer must be restarted in order for the network adapter to be recognized by the 

VibroSight discovery mechanism. 

 

4.5. Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 

27 characters were allowed in previous versions. This constraint is enforced during the creation of new 

server instances with VibroSight 2.9.6 or later. 

However, existing server instances may be non-compliant (too long) and no longer run after an 

upgrade of the VibroSight software. In such cases, the server instance name should be manually 

edited in the VibroSight database configuration file (*.vssrvcfg or *.config) to be 18 characters 

or less. Changes may also be required in any VibroSight software that references the server instance 

name, for example, associated VibroSight Vision Projects. 

For automated database copies that append a timestamp (_yyyyMMddHHmmss) to the Server 

instance name, the number that remain available for VibroSight Server instance names is deduced to 

3 characters. Alternatively, the server instance name can be shorted after the database copy is 

complete. 

 

4.6. VibroSight client connections to local and remote VibroSight Servers are 
mutually exclusive 

When a VibroSight Server is running on a (local) computer, a VibroSight client, such as VibroSight 

Configurator or VibroSight Vision running on the same (local) computer cannot connect to a VibroSight 

Server running on a different (remote) computer. 

 

4.7. VibroSight Servers listen to a single IP address 

VibroSight Servers use one specific IP address for connections to VibroSight clients. This IP address 

can be set to any of the available LAN adapters or logical addresses on the host computer, such that 

all traffic is directed through this address. However, this prevents concurrent connections from 

VibroSight clients running on other computers through different IP addresses. 
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4.8. Gaps in logged Modbus data 

When data logging with pre-trigger is used (for example, a time-based data logging rule with 

Pre Logging selected) or database operations such as a database copy or a database purge 

command occur at the same time as standard data logging, gaps can appear in the Modbus data that 

has been logged at a standard rate. 

These gaps in Modbus data are related to the computation of alarms when data is written to the 

database, which can be slow and can prevent some subsequent Modbus data from being handled 

correctly, especially when VibroSight Server is busy with other data intensive tasks. 
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5. Compatibility 

NOTE: Refer also to the latest version of the  Getting started with VibroSight 

installation guide or the  VibroSight software data sheet for further information 

on VibroSight’s prerequisites and compatibility. 

 

As part of the VibroSight software installation process, the installation wizard will automatically check 

to see if the “Microsoft Visual C++ Redistributable Package” (see section 5.1.5) and the “OPC Core 

Components Redistributable (x86)” (see section 5.1.6) are available on the computer. 

If these items have not previously been installed and they are required by the VibroSight installation’s 

application, then the VibroSight installation wizard can be used to install them. 

 

5.1. VibroSight software 

VibroSight 2.10.1 is a minor version release in the 2.10.x series and replaces VibroSight 2.10.0. 

Compatibility with existing databases is achieved using the database  Update tool (from 

VibroSight System Manager’s  Database tools) which supports the continued used of 

configurations and data from previous versions. See section 6.2.1. 

 

5.1.1. Microsoft Windows operating systems 

VibroSight 2.10.1 is compatible with 32-bit versions and 64-bit versions of Microsoft ® Windows ® 

operating systems. 

NOTE: Since VibroSight 2.9.0, VibroSight can run on 64-bit versions of Windows in order 

to help eliminate memory and performance issues that can occur due to the 

limitations of the 32-bit memory space. 

However, VibroSight 2.10.x remains 32-bit software that runs on x64 Windows in 

the same manner as it does on 32-bit windows, that is, VibroSight is "x64-

compatible" software (not "native x64" software). 

 

See the appendix of this document for detailed information on VibroSight software and Windows 

operating system compatibility. 
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5.1.2. Microsoft .NET Framework 

For most Windows operating systems, VibroSight 2.10.1 requires that the Microsoft .NET Framework 

4.5 is installed on the computer.  

NOTE: Microsoft .NET Framework 4.5 is required since VibroSight 2.9.4. 

Microsoft .NET Framework 4 (Standalone Installer) is required for VibroSight 2.9.2 

and 2.9.3. 

Microsoft .NET Framework 3.5 SP1 is required for VibroSight 2.9.1 or earlier. 

 

See the appendix of this document for detailed information on VibroSight software’s Microsoft .NET 

Framework requirements. 

 

5.1.3. Apple Bonjour 

Since VibroSight 2.9.6, Apple ® Bonjour is no longer required, as a proprietary implementation of the 

zero configuration networking (zeroconf) protocols is now used for all required networking operations: 

VibroSight hardware (XMx16 cards and VibroSmart DMS modules and devices) and software module 

discovery, VibroSight Server to hardware communications and inter-module communications. 

 

5.1.4. Sybase SQL Anywhere 11 software 

VibroSight uses the Sybase ® SQL Anywhere 11 database software in its standard configuration. 

VibroSight 2.10.1 remains compatible with the previously deployed version of SQL Anywhere, namely 

SQL Anywhere version 11.0.1.2044. 

NOTE: VibroSight requires the 32-bit version of SQL Anywhere 11 on both 32-bit and 64-

bit Windows operating systems. 

It is strongly recommended that only the 32-bit version of SQL Anywhere 11 is 

installed on the computer running VibroSight. 

 

NOTE: Updating SQL Anywhere to version 11.0.1.2867 is mandatory in order to avoid 

potential memory issues (fixed by Sybase). A software update (patch) included on 

the Sybase CD must be run in order to update Sybase SQL Anywhere from version 

11.0.1 to version 11.0.1.2867: SA11_Full_Win32+x64.1101_2867_EBF.exe. See 

section 6.3. 
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5.1.5. Microsoft Visual C++ Redistributable Package 

The Microsoft Visual C++ Redistributable Package is required in order to install and register the Visual 

C++ libraries required by a VibroSight OPC server. 

If this package does not already exist on the computer, then the VibroSight installation wizard will 

install it automatically. (The package is included in the ISSetupPrerequisites folder on the 

VibroSight CD.) 

NOTE: The Microsoft Visual C++ Redistributable Package is required since 

VibroSight 2.9.4, if VibroSight OPC servers are being used. 

The 32-bit version of the package (“vcredist_x86.exe”) is installed on both 32-bit 

and 64-bit Windows operating systems, as the VibroSight OPC server is a 32-bit 

application. 

 

5.1.6. OPC Foundation OPC Core Components Redistributable 

The OPC Core Components Redistributable is required in order to configure and run VibroSight OPC 

clients and OPC servers correctly: the redistributable must be installed on OPC client computers in 

order to allow connections to remote OPC servers and it must be installed on OPC server computers 

in order to allow OPC clients to browse for running OPC servers. 

If this redistributable does not already exist on the computer, then the VibroSight installation wizard 

will install it automatically. (The redistributable is included in the ISSetupPrerequisites folder on the 

VibroSight CD.) 

NOTE: The OPC Core Components Redistributable is required since VibroSight 2.9.4, if 

OPC clients or OPC servers are being used. 

The 32-bit version of the package (“OPC Core Components Redistributable (x86)”) 

is installed on 32-bit Windows operating systems and the 64-bit version of the 

package (“OPC Core Components Redistributable (x64)”) is installed on 64-bit 

Windows operating systems. 

 

 

5.2. VM600 cards 

5.2.1. Firmware 

There are no firmware updates for VibroSight-compatible VM600 cards corresponding to 

VibroSight 2.10.1. 

The latest firmware for the CPUR card remains: 

 Applications:  applications-640-012-001-003.tgz 

 Base System: base-system-640-011-001-003.tgz. 
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The latest firmware for the XMC16, XMV16 and XMVS16 cards remains: 

 Applications:  applications-640-010-001-007.tgz 

 Base System: base-system-640-003-001-008.tgz. 

Therefore, for current versions of the VibroSight-compatible VM600 cards, no firmware upgrades are 

required. 

 

5.3. VibroSmart DMS devices 

5.3.1. Firmware 

There are no firmware updates for the VibroSmart DMS modules and devices corresponding to 

VibroSight 2.10.1. 

The latest firmware for the VSI010 module remains: 

 642-002-001-002.xmsifw. 

The latest firmware for the VSN010 device remains: 

 642-004-001-003.redboxfw. 

The latest firmware for the VSV300 module remains: 

 642-001-001-004.xtranfw. 

Therefore, for current versions of the VibroSmart DMS modules and devices, no firmware upgrades 

are required. 

NOTE: VibroSight 2.10.1 contains features for VibroSmart DMS that have been activated 

in order to ensure compatibility with future releases of VibroSmart module firmware. 

However, this means that the current (or earlier) versions of the firmware for the 

VSI010 and VSV300 modules are not compatible with VibroSight 2.10.1. 
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6. Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. 

Perform the steps in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 

hardware (XMx16 cards and VibroSmart DMS modules and devices) before 

starting a VibroSight system upgrade, in order to establish if any firmware updates 

are also required. See section 6.4.3. 

 

 

6.1. Important notes 

6.1.1. Applications using VibroSight OPC Servers require that these servers are 
recreated in VibroSight 2.10.1 

VibroSight 2.10.1 contains an update to the VibroSight OPC Server software which means that the 

VibroSight OPC database file used to contain the data used by the OPC server is not compatible with 

earlier versions of the VibroSight OPC database file. 

Therefore, when updating applications using a VibroSight OPC Server to VibroSight 2.10.1, it is 

required to recreate the VibroSight OPC Server using the original VibroSight OPC Server 

configuration file (*.opcscfg). In VibroSight 2.10.1 System Manager: 

1. Delete the OPC server. 

(Select the VibroSight OPC Server under the host computer from the VibroSight Hosts tree 

structure in the System Explorer window and use the Delete command under the OPC Server 

tools in the Actions window.) 

2. Recreate the VibroSight OPC Server. 

(Select the host computer from the VibroSight Hosts tree structure in the System Explorer 

window and use the Create command under the OPC Server tools in the Actions window, 

using the original VibroSight OPC Server configuration file (*.opcscfg).) 

3. Load the configuration on the VibroSight OPC Server. 

(Select the recreated VibroSight OPC Server under the host computer from the 

VibroSight Hosts tree structure in the System Explorer window and use the 

Load Configuration command under the OPC Server tools in the Actions window.) 

4. Publish the VibroSight OPC Server. 

(Select the recreated VibroSight OPC Server under the host computer from the 

VibroSight Hosts tree structure in the System Explorer window and use the Publish command 

under the OPC Server tools in the Actions window.) 
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6.2. Upgrading the VibroSight software 

NOTE: Since VibroSight 2.9.6, VibroSight Server instance names are limited to 

18 characters (previously, it was 27). So VibroSight installations with VibroSight 

Server instance names of more than 18 characters will experience problems with 

VibroSight 2.10.x until the existing VibroSight Server instance names (and any 

references to them) are manually edited to be 18 characters or less. See 

section 4.5. 

 

1. If it is not necessary for the VibroSight-based system to remain operational during the upgrade 

procedure, back up any important (required) VibroSight databases in the following way: 

 Exit all VibroSight software modules (clients and servers) – no VibroSight software modules, 

such as Vision, Configurator or Server, should be running. 

 Copy the files (*.vssrvdb, *.vssrvcfg and optionally, *.log) from the directory 

where your database files are located to another location, for example, to a specific backup 

directory. 

 NOTE: The default data (data path) directory is C:\VibroSight Data 

Or if it is necessary for the VibroSight-based system to remain operational for as long as 

possible during the upgrade procedure, back up any important (required) VibroSight databases 

in the following way: 

 Exit all VibroSight software modules (clients) – no VibroSight software modules, such as 

Vision or Configurator, should be running. 

 Start VibroSight System Manager and use the database  Backup tool from VibroSight 

System Manager’s  Database tools, and follow the instructions presented by the 

Database Backup Wizard. 

 

 NOTE: It is necessary to be logged in to System Manager as ‘Admin’ in order to have the 

user rights to access the database tools: 

Select your  VibroSight Host (computer) in the System Explorer tree structure 

and click  Login (from VibroSight System Manager’s  Access Rights 

tools). 

 NOTE: Refer also to the Backing up a database topic in the  VibroSight help. 
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2. Make backup copies of any important (required) VibroSight Vision projects in the following way: 

 Create an archive file (for example, *.zip) containing all of the files (*.xml and 

*.xmsproj) in the directory where your project files are located. 

 NOTE: The default project directory is: 

C:\Documents and settings\username\My Documents 

\VibroSight\Projects 

 

3.  Ensure that no VibroSight software modules are running. 

4. Remove the currently installed version of the VibroSight software (for example,  

 VibroSight Standard Edition) using Windows Add or Remove Programs, in one of the 

following ways: 

 Click Start > Settings > Control Panel and then double-click Add or Remove Programs. 

 Or click Start, click Control Panel and then double-click Add or Remove Programs. 

5. Install the latest version of the VibroSight software by inserting the VibroSight CD into the 

CD/DVD drive of the computer and follow the instructions presented by the VibroSight 

installation wizard. 

NOTE: Refer to the  Getting started with VibroSight installation guide for detailed 

information on installing the VibroSight software – including prerequisites and 

compatibility. 

 

6. Restart VibroSight Server and ensure that the required communications are enabled. For 

example, enable card and module device drivers according to the hardware in the system: 

 For example, click Data > Acquisition > XMC16/XMV16 Card Driver or 

Data > Acquisition > VibroSmart Module Driver. 

7. Restart VibroSight Vision and ensure that live data is being received from the hardware and 

displayed in Vision. 

8. The VibroSight system is now up and running. 

 

6.2.1. Updating the internal structure of a VibroSight database 

When VibroSight Server is started, it checks the status of the database and will automatically inform 

the user if any internal structures of the database need to be updated before proceeding. 

1. Update a VibroSight database in the following way: 

 Start VibroSight System Manager and use the database  Update tool from VibroSight 

System Manager’s  Database tools, and follow the instructions presented by the 

Database Update Wizard. 
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 NOTE: It is necessary to be logged in to System Manager as ‘Admin’ in order to have the 

user rights to access the database tools: 

Select your  VibroSight Host (computer) in the System Explorer tree structure 

and click  Login (from VibroSight System Manager’s  Access Rights 

tools). 

 

 NOTE: Refer also to the Updating a database topic in the  VibroSight help. 

 

 

6.3. Upgrading the Sybase SQL Anywhere 11 software 

VibroSight software is compatible (and extensively tested) with Sybase SQL Anywhere versions 

11.0.0 and 11.0.1. 

However, with the release of SQL Anywhere version 11.0.1.2867, Sybase has fixed some previously 

known memory issues. Therefore, it is mandatory to upgrade all VibroSight systems to this version of 

SQL Anywhere 11. 

 

Determine the version of the SQL Anywhere 11 database engine installed on a computer in the 

following way: 

1. From the Start menu, click Start > All Programs > SQL Anywhere 11 > Sybase Central. 

The Sybase Central window appears. Sybase Central is a GUI-based management tool for 

Sybase products. 

2. Click Help > About Sybase Central. 

The About Sybase Central windows appears, displaying the version information for SQL 

Anywhere 11 (and any other installed Sybase products). 

 NOTE: Refer also to the Determining the version of SQL Anywhere 11 installed on a 

computer topic in the  VibroSight help. 

 

If SQL Anywhere 11 version 11.0.0 is installed on the computer, it is necessary to first remove 

version 11.0.0, then install version 11.0.1 from the Sybase CD. 

If SQL Anywhere 11 version 11.0.1 is installed on the computer, simply update to version 11.0.1.2867 

by running the software update (patch) included on the Sybase CD. 
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When SQL Anywhere 11 software version 11.0.0 is installed on the computer: 

NOTE: Do not use the SQL Anywhere 11.0.1 setup to upgrade directly to software version 

11.0.1 from software version 11.0.0. Instead, it is necessary to upgrade the Sybase 

database software as follows: 

1. Remove SQL Anywhere 11.0.0, using the Windows Add or Remove Programs 

tool. 

2. Install SQL Anywhere 11.0.1, using the Sybase SQL Anywhere 11.0.1 CD. 

Refer also to the  Getting started with VibroSight installation guide for 

information on installing the Sybase software. 

 

1. Exit all VibroSight software modules (clients and servers) – no VibroSight software modules, 

such as Vision, Configurator or Server, should be running – as this also stops the SQL 

Anywhere 11 database engine. 

The  lightning icon that appears in the notification area (at the far right of the task bar) to 

indicate that a Sybase database engine is running should no longer be shown. 

2. Remove the currently installed version of Sybase SQL Anywhere 11 using Windows Add or 

Remove Programs, in one of the following ways: 

 Click Start > Settings > Control Panel, then double-click Add or Remove Programs 

 Or click Start, click Control Panel and then double-click Add or Remove Programs. 

And remove  SQL Anywhere 11. 

3. Restart the computer. 

4. Install Sybase SQL Anywhere VibroSight 11.0.1.2044 by inserting the Sybase CD into the 

CD/DVD drive of the computer and following the instructions presented by the 

SQL Anywhere 11 installation wizard. 

5. Restart the computer. 

Without this final computer restart, VibroSight Server may not be able to start the 

SQL Anywhere 11 database engine. 

 

When SQL Anywhere 11 software version 11.0.1 is installed on the computer: 

1. Update to Sybase SQL Anywhere VibroSight 11.0.1.2867 by inserting the Sybase CD into the 

CD/DVD drive of the computer, running the SA11_Full_Win32+x64.1101_2867_EBF.exe 

software update (patch) and following the instructions presented by the SQL Anywhere 11 

installation wizard. 

2. Restart the computer. 
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6.4. Updating the VibroSight hardware 

Appropriate files and tools are included in the installation package to allow VM600 cards (CPUR and 

XMx16) and VibroSmart DMS devices (VSI010, VSN010 and VSV300) to be updated to the latest 

standard, in order to take advantage of improvements to the VibroSight software. 

 

6.4.1. VM600 card firmware 

The latest VM600 card firmware files are copied to a directory on your computer as part of the 

VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600 cards is: 

C:\Program Files\Meggitt\VibroSight 2\Firmware\VM600 

 

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their 

.tgz file name extension. For example, the XMV16 subfolder contains the applications and base 

system firmware for use by XMV16 cards. Any additional firmware updates received from Meggitt 

Sensing Systems should also be stored in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that 

is, XMC16, XMV16 and XMVS16 card pair firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 XMx16 

card firmware that is compatible with the version of VibroSight software being used. 
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Table 1: VibroSight software and VM600 XMx16 card firmware compatibility 

 VM600 XMx16 card firmware 

VibroSight 

software version 

CD part number 

Applications (*.tgz) 

640-010- 

001-001 

640-010- 

001-002 

640-010- 

001-003 

640-010- 

001-004 

640-010- 

001-005 

640-010- 

001-006 

640-010- 

001-007 

Base-system (*.tgz) 

640-003- 

001-002 

640-003- 

001-003 

640-003- 

001-004 

640-003- 

001-005 

640-003- 

001-006 

640-003- 

001-007 

640-003- 

001-008 

2.5.0 

609-004-000-006 
 

  
    

2.7.5 

609-004-000-008 
  

 
    

2.8.0 

609-004-000-007 
  

 
    

2.9.0 

609-004-000-010 

  
     

2.9.1 

609-004-000-011 
       

2.9.2 

609-004-000-012 
       

2.9.3 

609-004-000-013 
       

2.9.4 

609-004-000-014 
       

2.9.5 

609-004-000-015 
       

2.9.6 

609-004-000-016 
       

2.9.7 

609-004-000-017 
      

See note 1
 

2.10.0 

609-004-000-018 
      

See note 1
 

2.10.1 

609-004-000-019 
      

See note 1
 

Notes for Table 1 – See the next page. 



     

 
 

   

     

 

     
 Release Notes VIBROSIGHT-RN/E (660-010-013-201A) 

Release 2.10.1 – October 2013 27 / 36  

     
 

Notes for Table 1 

1. Updating to this version of VM600 XMx16 card firmware requires a two step process: (i) VibroSight System Manager’s 

Change Firmware command should be used to update the base-system firmware (640-003-001-008.tgz) only, then (ii) the 

Change Firmware command should be used again to update the applications firmware (640-010-001-007.tgz) only. 

 

 

6.4.2. VibroSmart DMS device firmware 

The latest VibroSmart DMS device firmware files are copied to a directory on your computer as part of 

the VibroSight software installation process. 

NOTE: The default firmware directory for VibroSmart DMS devices is: 

C:\Program Files\Meggitt\VibroSight 2\Firmware\VibroSmart 

 

The firmware files for a VibroSmart DMS device can be found in the appropriate subfolder and 

identified by their .*fw file name extension. For example, the VSV300 subfolder contains the firmware 

for use by VSV300 modules. Any additional firmware updates received from Meggitt Sensing Systems 

should also be stored in these directories. 

Table 2 shows the compatibility between VibroSight software and the VibroSmart VSI010 module 

firmware. 

Table 3 shows the compatibility between VibroSight software and the VibroSmart VSN010 device 

firmware. 

Table 4 shows the compatibility between VibroSight software and the VibroSmart VSV300 module 

firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart DMS 

firmware that is compatible with the version of VibroSight software being used. 
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Table 2: VibroSight software and VibroSmart VSI010 module firmware compatibility 

 
VibroSmart DMS device 

firmware 

VibroSight 

software version 

CD part number 

VibroSmart VSI010 module 
See note 1

 

642-002-001-

001.xmsifw 

642-002-001-

002.xmsifw 

2.8.0 

609-004-000-007 
  

2.9.1 

609-004-000-011 
  

2.9.2 

609-004-000-012 
  

2.9.3 

609-004-000-013 
  

2.9.4 

609-004-000-014 
  

2.9.5 

609-004-000-015 
  

2.9.6 

609-004-000-016 
  

2.9.7 

609-004-000-017 
  

2.10.0 

609-004-000-018 
  

2.10.1 

609-004-000-019 

See note 2
 

 

Notes for Table 2 

1. It is strongly recommended to restart a VibroSmart DMS device before updating its firmware. For example, by turning the 

power supply to the device off and on, or removing and re-inserting the device. 

2. VibroSight 2.10.1 contains features that have been activated in order to ensure compatibility with future releases of 

VibroSmart DMS device firmware. However, this means that VibroSight 2.10.1 is not compatible with the current (or earlier) 

versions of the VSI010 firmware. See section 5.3. 

 



     

 
 

   

     

 

     
 Release Notes VIBROSIGHT-RN/E (660-010-013-201A) 

Release 2.10.1 – October 2013 29 / 36  

     
 

Table 3: VibroSight software and VibroSmart VSN010 device firmware compatibility 

 VibroSmart DMS device firmware 

VibroSight 

software version 

CD part number 

VibroSmart VSN010 device See note 1 

642-004-001-

001.redboxfw 

642-004-001-

002.redboxfw 

642-004-001-

003.redboxfw 

2.8.0 

609-004-000-007 
  

 

2.9.1 

609-004-000-011 
  

 

2.9.2 

609-004-000-012 
  

 

2.9.3 

609-004-000-013 
  

 

2.9.4 

609-004-000-014 
  

 

2.9.5 

609-004-000-015 
  

 

2.9.6 

609-004-000-016 
  

 

2.9.7 

609-004-000-017 
  

 

2.10.0 

609-004-000-018 
 

  

2.10.1 

609-004-000-019 
 

  

 

Notes for Table 3 

1. It is strongly recommended to restart a VibroSmart DMS device before updating its firmware. For example, by turning the 

power supply to the device off and on, or removing and re-inserting the device. 
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Table 4: VibroSight software and VibroSmart VSV300 module firmware compatibility 

 VibroSmart DMS device firmware 

VibroSight 

software version 

CD part number 

VibroSmart VSV300 module See note 1 

642-001-001-

001.xtranfw 

642-001-001-

002.xtranfw 

642-001-001-

003.xtranfw 

642-001-001-

004.xtranfw 

2.8.0 

609-004-000-007 
  

  

2.9.1 

609-004-000-011 
   

 

2.9.2 

609-004-000-012 
   

 

2.9.3 

609-004-000-013 
   

 

2.9.4 

609-004-000-014 
   

 

2.9.5 

609-004-000-015 
  

  

2.9.6 

609-004-000-016 
  

  

2.9.7 

609-004-000-017 
  

  

2.10.0 

609-004-000-018 
 

   

2.10.1 

609-004-000-019 
See note 2

 

 

Notes for Table 4 

1. It is strongly recommended to restart a VibroSmart DMS device before updating its firmware. For example, by turning the 

power supply to the device off and on, or removing and re-inserting the device. 

2. VibroSight 2.10.1 contains features that have been activated in order to ensure compatibility with future releases of 

VibroSmart DMS device firmware. However, this means that VibroSight 2.10.1 is not compatible with the current (or earlier) 

versions of the VSV300 firmware. See section 5.3. 
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6.4.3. Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade 

the firmware of VM600 XMx16 cards and VibroSmart DMS devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600 card firmware update may lead to 

incoherent system behaviour and affect the proper functioning of data acquisition in a system. It is only 

in systems where the firmware running on the XMx16 cards and VibroSmart DMS devices already 

corresponds to the latest available version that no firmware update is required. Therefore, it is strongly 

recommended to verify the version of firmware running on the hardware before starting a VibroSight 

system upgrade, in order to establish if a firmware update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 

that can – if performed unintentionally – affect the proper functioning of data 

acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 

hardware only when it is necessary. For example, when the devices must be 

updated to be compatible with a VibroSight software upgrade. 

 

NOTE: It is strongly recommended to restart a VibroSmart DMS device before updating its 

firmware. For example, by turning the power supply to the device off and on, or 

removing and re-inserting the device. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight 

System Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the 

hardware (XMx16 card or VibroSmart DMS module or device) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System 

Explorer window. 

The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the 

network. If there are no XMx16 cards or VibroSmart DMS devices in the tree structure or some 

cards are missing, verify your network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 
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5. Click the Add button and select the new firmware files for the card or new firmware file for the 

device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 

corresponding to the VibroSight-compatible VM600 card or VibroSmart DMS 

device selected. 

.tgz files are for VM600 cards and .*fw files are for VibroSmart DMS devices. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart DMS devices, the firmware upgrade process can take up to 

5 minutes, during which: 

 The IP address beside the device’s serial number in the Devices tree structure can 

disappear. 

 The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update.  

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 

independently of the VibroSight software (once the process has started), firmware 

updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of 

firmware. It is therefore possible to change a device’s firmware to any previously available version, as 

well as the latest update. 

This feature can be useful in certain situations, for example, swapping spare VibroSight hardware 

between different VM600 racks or VibroSmart DMSs, where systems are operating with different 

versions of VibroSight. 
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6.5. Final checks 

After upgrading the VibroSight software, the following checks are recommended to ensure that 

VibroSight has not been inadvertently modified and that it continues to operate as expected: 

 Use VibroSight Configurator to run a consistency check on the configuration in order to ensure 

that the configuration has not been modified by any changes to the VibroSight software, 

internal database structure and firmware for the hardware (VM600 cards and VibroSmart DMS 

modules). 

 Use the VibroSight Server window to check that the data acquisition, data post-processing and 

data logging settings are as expected. (Click Data > Acquisition, Data > Post-processing 

and Data > Logging and disable/enable the drivers, processing managers and logging as 

required.) 

 

 

  



     

   
 

 

     

 

     
 34 / 36 Release Notes VIBROSIGHT-RN/E (660-010-013-201A) 

Release 2.10.1 – October 2013 
 

     
 

7. Customer support 

7.1. Contacting us 

Meggitt Sensing Systems worldwide customer support network offers a range of support including 

Technical support and Sales and repairs support. For customer support, please contact your local 

Meggitt Sensing Systems representative. Alternatively, contact our main office: 

Customer support 

Meggitt SA 

Route de Moncor 4 

PO Box 1616 

CH-1701 Fribourg 

Switzerland 

 

Telephone: +41 (0) 26 407 11 11 

Email: energysupport@ch.meggitt.com 

Web: www.meggittsensingsystems.com 

 

7.2. Technical support 

Meggitt Sensing Systems technical support team provide both pre-sales and post-sales technical 

support, including: 

 General advice 

 Technical advice 

 Troubleshooting 

 Site visits. 

 

7.3. Sales and repairs support 

Meggitt Sensing Systems sales team provide both pre-sales and post-sales support, including advice 

on: 

 New products 

 Spare parts 

 Repairs. 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensingsystems.com/
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VibroSight software and Windows operating system compatibility 

 
Windows XP and 

Windows Server 2003 R2 

Windows Vista and 

Windows Server 2008 

Windows 7 and 

Windows Server 2008 R2 

Windows 8 and 

Windows Server 2012 

VibroSight software 

compatible? 

Yes, but not recommended for 

new installations as Microsoft 

support for Windows XP SP3 

ends on 08 April 2014 

Yes, but not recommended. 

Windows Server 2008 R8 

should be used instead of 

Windows Server 2008 

Yes – recommended for new 

installations 
To be announced 

 

Microsoft .NET Framework versions pre-installed on Windows operating systems 

 
Windows XP and 

Windows Server 2003 R2 

Windows Vista and 

Windows Server 2008 

Windows 7 and 

Windows Server 2008 R2 

Windows 8 and 

Windows Server 2012 

Microsoft .NET Framework 

pre-installed on Windows 

operating system 

None on XP. 

.NET Framework 2.0 on 

Server 2003 R2 

.NET Framework 3.0 .NET Framework 3.0 SP1 .NET Framework 4.5 

 

VibroSight software’s Microsoft .NET Framework requirements 

VibroSight software version 
Windows XP and 

Windows Server 2003 R2 

Windows Vista and 

Windows Server 2008 

Windows 7 and 

Windows Server 2008 R2 

Windows 8 and 

Windows Server 2012 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 .NET Framework 3.5 SP1 .NET Framework 3.5 SP1 .NET Framework 3.5 SP1 

VibroSight 2.9.2 and 2.9.3 .NET Framework 4 .NET Framework 4 .NET Framework 4 .NET Framework 4 

VibroSight 2.9.4 or later .NET Framework 4
 1
 .NET Framework 4.5 .NET Framework 4.5 .NET Framework 4.5 

 


